Saba Centra Live 7.6

Essentials Guide

Part Number: G-EG-SC760-0
Limitations on Warranties and Liability

Saba Software, Inc. reserves the right to make changes in information contained in this document without notice.

In no event shall Saba or its suppliers be liable for any damages whatsoever (including, without limitation, damages for loss of business profits, business interruption, loss of business information, or any other pecuniary loss) arising out of or relating to this documentation or the information contained in it, even if Saba has been advised of the possibility of such damages and whether arising from tort (including negligence), breach of contract or otherwise.

This document may only be reproduced and distributed in whole for use by licensed users. No part of this document may be reproduced in any form for any other purpose without the prior written consent of Saba Software, Inc.

The software described in this documentation is copyrighted and is confidential information and a proprietary product of Saba Software, Inc.

U.S. GOVERNMENT RESTRICTED RIGHTS. If licensee is the United States Government or any contractor thereof, all licenses granted in the License Agreement accompanying this product are subject to the following: (i) for acquisition by or on behalf of civilian agencies, as necessary to obtain protection as "commercial computer software" and related documentation in accordance with the terms of this Commercial Software Agreement as specified in 48 C.F.R. 12.212 of the Federal Acquisition Regulations and its successors; (ii) for acquisition by or on behalf of units of the Department of Defense ("DOD") as necessary to obtain protection as "commercial computer software" and related documentation in accordance with the terms of this commercial computer software license as specified in 48 C.F.R. 227-7202-2 of the DOD F.A.R. Supplement and its successors.

Saba, the Saba logo and Centra are registered trademarks of Saba Software, Inc. and Saba and Saba Centra product names are the trademarks of Saba Software, Inc. All other product names mentioned in this manual are the property and may be trademarks or registered trademarks of their respective owners, and are used for identification purposes only.

© 2007 Saba Software, Inc. All rights reserved.
# Table of Contents

## Chapter 1  Introduction .................................................. 1
- Overview ................................................................. 1
- Server and Client Requirements .................................. 1
- Saba Centra Multi-Lingual Support ................................ 1
- Saba Centra Technical Support ..................................... 2
- Training, Education and Certification ............................ 2
- Other Information Resources ......................................... 2

## Chapter 2  Getting Started ............................................... 3
- Overview ................................................................. 3
- Using Public Navigation Bar ........................................ 3
  - Public Events Page .................................................. 4
- Creating a New User Account ...................................... 5
  - Account Tips ......................................................... 5
  - Login Tips ........................................................... 5
- Enrolling in an Event .................................................... 5
  - Unenrolling from an Event ....................................... 6
- Attending an Event and Installing Centra .......................... 6
  - Getting Started Page ............................................... 6
- Editing your Profile ..................................................... 7
- Creating a Meeting ...................................................... 7
- Saba Centra Connectivity Tips ..................................... 7

## Chapter 3  Saba Centra User Interface ................................. 9
- Overview ................................................................. 9
  - Interface Components ............................................. 9
  - Network Status Indicator ........................................ 11
- Saba Centra Participant ............................................... 12
  - Participant Tips ....................................................... 12

## Chapter 4  Audio ............................................................ 13
- Using the Audio Wizard .............................................. 13
- Teleconference Audio ................................................ 13
- Audio Troubleshooting Guidelines .................................. 14

## Chapter 5  Content Developer ............................................. 15
- Using Agenda Builder ............................................... 15
  - Opening Agenda Builder ......................................... 15
  - Creating an Agenda ............................................... 15
  - Drag and Drop Content into an Agenda ....................... 16
  - Adding an Evaluation ............................................. 16
Deleting Content from an Agenda ................................. 16
Saving an Agenda .................................................. 16
Tips for Creating an Agenda ...................................... 17
Language Considerations for Agendas .......................... 17
Supported Content .................................................. 17
Using Recording Studio .......................................... 19
  Launching Recording Studio .................................... 19
  Creating Recordings ............................................. 19
  Editing Recordings .............................................. 20
  Saving Recordings .............................................. 20

Chapter 6  Event Manager............................................ 23
  Scheduling an Event ............................................ 23
    Registered Users Only Events ................................. 24
    Scheduling Tips ............................................... 24
  Setting up Virtual Labs (for Symposium Events Only) .... 24
  Enrolling Users or Groups .................................... 25
  Special Roles in an Event ..................................... 25
    Assigning Special Roles ...................................... 26
    Guest Attend ................................................... 26

Chapter 7  Leader ..................................................... 27
  Before Beginning an Event ................................... 27
  Inviting Additional Participants ............................... 27
  Leader Functions ............................................... 28
  Importing a PowerPoint Presentation .......................... 29
    Import Tips ................................................... 29
  Inserting a URL ................................................ 29
  Inserting an Agenda ........................................... 30
  Inserting a File to Download .................................. 30
  Clearing the Agenda .......................................... 30
  Co-Presenters .................................................. 30
  Showing Content in Session .................................. 31
  Navigating the Agenda ........................................ 31
  Deleting Imported Content .................................... 31
  Using Web Safari .............................................. 32
  Using Appshare ................................................ 32
    Marking up an Application ................................... 33
    Appshare Options ............................................. 34
  Using the Whiteboard ......................................... 34
  Saving the Markup to the Agenda ............................... 34
    Clearing the Markup ......................................... 35
  Creating a Survey .............................................. 35
  Displaying an Evaluation ..................................... 36
  Using Breakout Rooms ......................................... 36
    Creating Breakout Rooms .................................... 36
    Moving a Participant to a Room ......................... 37
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Selecting Breakout Room Content</td>
<td>37</td>
</tr>
<tr>
<td>Changing Breakout Roles</td>
<td>37</td>
</tr>
<tr>
<td>Starting and Stopping Breakouts</td>
<td>38</td>
</tr>
<tr>
<td>Symposium and eMeeting Leader</td>
<td>38</td>
</tr>
<tr>
<td>Conference Leader</td>
<td>38</td>
</tr>
<tr>
<td>Leader Tips</td>
<td>38</td>
</tr>
<tr>
<td>Managing Virtual Labs (Symposium Events Only)</td>
<td>39</td>
</tr>
<tr>
<td>Accessing the Manage Virtual Labs Page</td>
<td>39</td>
</tr>
<tr>
<td>Assigning Labs</td>
<td>40</td>
</tr>
<tr>
<td>Replacing a Lab Assignment</td>
<td>40</td>
</tr>
<tr>
<td>Starting and Stopping Labs</td>
<td>40</td>
</tr>
<tr>
<td>Monitoring Labs</td>
<td>41</td>
</tr>
<tr>
<td>Broadcasting Video</td>
<td>41</td>
</tr>
<tr>
<td>Enabling Video Broadcasting</td>
<td>41</td>
</tr>
<tr>
<td>Enabling and Disabling Video During a Session</td>
<td>42</td>
</tr>
<tr>
<td>Using the Saba Centra Video Wizard</td>
<td>42</td>
</tr>
<tr>
<td>Starting Video Broadcast</td>
<td>43</td>
</tr>
<tr>
<td>Selecting Single-Video or Multi-Video Mode</td>
<td>43</td>
</tr>
<tr>
<td>Video Panel</td>
<td>43</td>
</tr>
<tr>
<td>Using Video Controls</td>
<td>43</td>
</tr>
<tr>
<td>Using the Video Menu</td>
<td>44</td>
</tr>
<tr>
<td>Granting Video Control</td>
<td>44</td>
</tr>
</tbody>
</table>
Overview

The goal of this document is to provide users (Participants and Leaders) with the basic functions, and reinforce familiarity with the appearance and navigation functions in the Saba Centra product.

This document was created with the intention of the content being translated for localization purposes.

Note: All references to Saba Centra 7 in this document are to Saba Centra 7 Version 7.6 unless otherwise specified.

Server and Client Requirements

For current Server and Client requirements, please visit:
http://support.saba.com/ > Library
and locate Saba Centra 7.6 Server and Client Requirements.

Saba Centra Multi-Lingual Support

Saba Centra offers multi-lingual support. Organizations can install multiple languages on a single Saba Centra Server. Users with different language versions of the Saba Centra interface can attend the same event.

Users set their language preference on the My Profile page and can update it at any time. Users can also change their preferred language on the logon page. When users log in to the Saba Centra Server, the Saba Centra pages and the client appear in the user’s language.

Notes:

- Centra does not translate audio, data, or event content.
It is recommended the client computer operating system and regional settings are the same as the user’s preferred language. If not, there may be problems with the display and functionality of Saba Centra if the operating system does not support the proper fonts.

Saba Centra Technical Support

Saba Centra’s dedicated Technical Support team welcomes questions, comments, and feedback, to help us improve our products and services.

Contact the Saba Centra Technical Support staff at http://support.saba.com

Documentation for Saba Centra products is located on the support site.

Training, Education and Certification

The effectiveness of Administrators, Event Managers, Agenda Builders, and Event Leaders, whether novice or experienced, depends on their knowledge of how best to use Saba Centra tools, controls, and features.

Consider joining one of Saba Centra’s Training, Education and Certification programs to increase knowledge of Saba Centra products.

Saba Centra Education and Training Services offers online Symposium sessions, workshops, and programs designed specifically for each type of user. Work with Saba Centra staff and other Leaders to learn about and gain experience with Saba Centra products.

For more information about Saba Centra Education and Training Services, visit our Online Course Catalog at http://support.saba.com

Other Information Resources

Access online help from the following areas:

- From the Saba Centra Home Page, click Help.
- For Administrator access, go to the Administrator menu and click Administrator Help.
- In a Symposium or Conference session, select Content and Search from the Help menu.
- For documentation, public or private (requires login), go to http://support.saba.com/ > Library
Overview

This chapter provides information about attending a Saba Centra event and the functions necessary for using the Saba Centra product. To attend a Saba Centra event one of the following must exist:

- Saba Centra user account or
- Invitation as a “guest” or
- Attendance at a Public Event.

Note: Public Events do not require a previous account.

Using Public Navigation Bar

The public navigation bar appears on the left side of pages that users access without logging in. The public navigation bar contains links to other pages.

Users can visit Public Events and Public Recordings without logging in.

Other links in the public navigation bar provide shortcuts to pages that users cannot visit without first logging in:

- My Schedule
- Create Meeting
- Create Account

When users click My Schedule, Create Meeting, they are directed to the Log In page. After logging in, they are directed to the My Schedule or Create Meeting.

When user click Create Account, they are directed to the Create User Account page. Once completed, the new user can click the available links.
Public Events Page

The Public Events page allows users to access public events. This page contains the following features:

- The public navigation bar described above
- Search Field
- Public events list

The following sections describe the Search field and the Public Events List.

Search Field

The Search field enables users to access both private events and public events. Private events are not listed in the public events list. To access a private event, users can enter the event ID of the event in the Search field and click Search. If an exact match is found, users navigate directly to the Event Details page. The Event Details page contains a complete description of the event, as well as an Attend link that users can click if they choose to attend the event.

**Note:** It is not possible to use event IDs to find Webinars. Webinars do not display event IDs.

To search for public events, users can enter the event ID, event name, description, or leader's last name in the Search field and then click **Search**. Any matches that are found are listed in the Public Events List. Users can click the name in the Event column to navigate to the Event Details page.

Attend by Event ID Field

Administrators can limit the display in the Public Events page to a single field, into which users enter the event ID of a private event or part of the name of a public event.

Public Event List

The public event list contains links that users can click to attend events or view details about events:

Users can attend public events without entering the event IDs for these events. The public event list includes all public events except those whose start dates are before the current date. Webinars are included in the public event list if their status is “Approved” or “Past”.

- Click the “Attend” link to attend the event or meeting.
- Click the “Register” link to go to a Webinar’s registration page (Webinars only)
- “Not Started” displays if the event in not on-going and the current time is outside of the early attendance window.
- “Event Over” displays for events and meetings that have ended.
Creating a New User Account

Use the following instructions to create a Centra user account.
1. Launch a browser.
2. In the browser Address or Location field, enter the name of the organization's Saba Centra Server and press the Enter key.
3. Click Create Account.
4. Enter all required information.
5. Click Create. The My Schedule page appears.

Account Tips
- The Login and Password fields are case sensitive.
- Display name is the name other users will see listed in the Attendees list during an event.
- Change the user account information in My Profile.
- If the System Administrator has not installed any additional language packs, the Language drop-down list will not appear.

Login Tips
- The Login and Password fields are case sensitive.
- Click Forget your password and to receive an email containing the password. (This link appears only if email is enabled on the Saba Centra Server.)
- Cookies must be enabled on the browser to use the Remember me feature.

Enrolling in an Event

It is possible to enroll in an event before it begins or be invited as a guest attendee. Once enrolled, attend the event or view the recording.

Note: Not all events are listed on the Event List. Check with the Event Manager for information on joining an event.

Use the following instructions to enroll in an event:
1. From the My Schedule page, click Event List.
2. In the Event column, locate the name of the event to enroll in and click Enroll. The link changes from Enroll to Enrolled.
   Note: If the enrollment for the event is full, contact the Event Manager.
3. Click My Schedule to view the name and start time for each event. Check the Upcoming and Ongoing tabs.
Unenrolling from an Event

1. Click My Schedule.
2. Locate the name of the event to unenroll and click Unenroll.

The event no longer appears on the My Schedule page.

Attending an Event and Installing Centra

The My Schedule page shows the name and start time for all the events where the user is enrolled. When attending an event, Centra checks if Saba Centra client is installed. If the client is not installed, a prompt appears requesting an installation.

Use the following instructions to attend an event:

1. Click My Schedule and locate the name of the event to attend.
2. If Download appears, click the link to download content. Select Automatic Download and click Proceed.
   A popup window indicates a download is in progress. The amount of time for the download depends on the connection speed and the amount of content downloaded.
3. Click Attend to enter that event.

Saba Centra verifies if the client is installed. If the client:
   □ IS installed, interface appears.
   □ IS NOT installed, a prompt appears to download the client. When using Internet Explorer, the client is automatically installed. When using Netscape, accept the Netscape plug-in (if necessary) and the client is automatically installed.

Click Yes in the Security dialog box, if necessary. When done, the Symposium, Conference, or eMeeting interface appears.

Note: If the event cannot be accessed, contact the System Administrator.

Getting Started Page

The Getting Started page appears to help users perform their next task:

Users can use the links on this page to perform the following:

- Prepare to talk in the event.
- Invite additional users to join.
- Import a presentation.
- Share an application.
Editing your Profile

Change the user account information for Saba Centra by editing your Profile.

**Note:** It is not possible to change the login.

Use the following instructions to edit your user profile:

1. Log in to the Saba Centra Server.
2. On the My Schedule page, click **My Profile**.
3. Edit all fields that require new information.
4. Click **Submit**. The My Schedule page appears.

Creating a Meeting

A meeting is a quick way to collaborate with a group of people. By default, any user can schedule a meeting. The individual who creates the meeting is automatically the Leader and controls who is invited.

It is not possible to attach a Subject and Agenda to a meeting, only import content while in session. The meeting does not appear on the public Event List unless specified to appear.

**Note:** To create a Symposium or Conference event, requires Event Manager privileges.

Use the following instructions to create a meeting:

1. Click **Create Meeting** on the My Schedule page.
2. Enter all required information.
3. Click **Create**. The meeting now appears on the My Schedule page.

**Note:** The creator is automatically the Leader of the event.

Saba Centra Connectivity Tips

Check the following if an error is encountered:

**Page not found**

- Verify the correct URL address. Confirm the URL with the System Administrator.

**Access the Saba Centra Welcome page but cannot log in**

- Verify the correct login and password. These fields are case sensitive. Verify the Saba Centra user account.

**Cannot find the event to attend on the My Schedule page**

- Click the **Past** tab. Verify if the event has already occurred.

**Click on the Attend link, but the Saba Centra client does not launch**
A “login ID already in use” the use is already attending the event on another PC, using the same login as another user, have another version of the client open, or clicked the Attend link more than once.

Use the following instructions to install the Saba Centra client:

1. Click the Install Saba Centra 7 link in the Saba Centra Setup window.
2. Click Open or Save. Then follow the directions to install the client.
3. When the installation is complete, click launch Saba Centra 7 in the Saba Centra Setup window.

The Saba Centra client was installed, but this window continues to appear, do one of the following:

- If this process was done on one server, but the event is on a different server, click launch Saba Centra in the Saba Centra Setup window. The installation is recognized on a server by server basis.
- Disabling cookies in the browser requires installing the Saba Centra client for each event. Enable cookies in the browser to avoid this process. See the System Administrator for assistance.

Trouble connecting to the event or Saba Centra Server:
Close all other applications on the computer and reboot the machine.

Other problems:
Contact the System Administrator or Saba Centra Technical Support.
Overview

This chapter illustrates and explains the Saba Centra client user interface for Participants and Leaders.

The Saba Centra client user interfaces (Participant and Leader) contain the following components.

Interface Components
Title Bar
The Title bar appears at the top of the Saba Centra interface. During a Symposium Breakout Session, the Title bar updates to show the number of the Breakout Room.

Standard Windows buttons appear at the right end of the Title bar. Use these buttons to minimize, maximize, or close the Saba Centra interface.

Menu Bar
The menu bar for Participants and Leaders contain functions of the Toolbar, plus additional functions. For example, click Tools and choose Audio Wizard.

*Note:* Some functions appear in Symposium and eMeeting, not Conference.

Toolbar
The Toolbar buttons available to Participants and Leaders for quick access to the available functions. The title of these functions is available when placing the mouse over the button.

*Note:* Not all buttons are available in every product. Other buttons, such as Video, appear if those features are enabled.

Audio Area
The Audio area indicates microphone or speaker activity.

- Yellow bars indicate sending or receiving audio.
- Adjust the sliders to control the microphone and speaker levels.

*Note:* Adjusting the microphone is available if **Automatically adjust microphone level** is not selected in the Audio Wizard.

- Click the Talk button or press the Ctrl key or F12 (default) key to speak during an event.

*Note:* Speaking requires the event leader to provide a microphone.

- Click Lock to Talk to speak 'hands free' for an extended time.
- Click again when done to allow others to speak.
- If the event is using Teleconference audio, the audio area does not appear.

Video Panel
The Video panel opens when video services are started. The broadcaster appears in the panel. See “Broadcasting Video” for details.

Presenters Area
The Presenters area lists the Leader and Co-Presenters for the event. The Leader’s name appears first and is followed by any Co-Presenters.

Participants List
The Participants List shows the Participants in the event.

In Symposium and eMeeting, click the associated button above the list of names to
sort the Participant List by microphone, Yes or No responses, raised hands, or Participant names. In a Participant interface, the user’s name appears at the top of the list. To view another Participant’s full name, hold the mouse over the Participant’s name. A summary area shows the total number of Participants who responded Yes or No, laughing, clapping, or raised a hand. It also shows the total number of Participants in the Main Room.

Agenda Area

The Agenda area lists the content for the event in the form of an Agenda. Leaders and Co-Presenters use an Agenda during an event as a guide to select and show content and tools.

Status Bar

The Status bar indicates whether the event is in pre-session or in-session mode, or if the event is being recorded.

Conference and eMeeting are considered “in session” as soon as the Leader or Co-Presenter enters. In Symposium, the Leader must explicitly begin the event.

If the event is using a Saba Centra Telephony Gateway to record teleconference audio, the Gateway status appears as Not Connected, Dialing or Connected.

Media Window

The Media Window shows the Agenda item or tool (such as Appshare, Web Safari, or Whiteboard) currently being used.

Network Status Indicator

A Network Status Indicator appears in the lower right corner of the Saba Centra Symposium, Conference, and eMeeting interface. Five lights indicate the quality of the network connection:

<table>
<thead>
<tr>
<th>State</th>
<th>Indicator</th>
</tr>
</thead>
<tbody>
<tr>
<td>Optimal connection</td>
<td>4 –5 green lights</td>
</tr>
<tr>
<td>Better connection</td>
<td>3-4 yellow lights</td>
</tr>
<tr>
<td>Good connection</td>
<td>2-3 yellow lights</td>
</tr>
<tr>
<td>Fair connection</td>
<td>1-2 yellow lights</td>
</tr>
<tr>
<td>Poor connection</td>
<td>1 red light</td>
</tr>
<tr>
<td>Disconnected</td>
<td>5 red lights</td>
</tr>
<tr>
<td>Reconnected</td>
<td>2 red lights</td>
</tr>
<tr>
<td>Reattending</td>
<td>3 red lights</td>
</tr>
</tbody>
</table>
Saba Centra Participant

A Participant uses Saba Centra to attend or playback Public Events or enroll in and attend live events. Participants can perform the following:

- Speak to the Leader and other Participants (with a microphone).
- Raise their hand.
- Respond to questions with a Yes or No answer.
- Use markup tools.
- Applaud or laugh using icons.
- Communicate with others using Text Chat.
- Play back a recording of an event.
- Use the View menu to change the interface display.
- Broadcast video (Symposium and eMeeting).
- Interact with or share an application (Symposium and eMeeting).
- Browse course content before an event begins (Symposium and Conference).
- View content in the Content Catalog.
- Participate in a Survey or in an Evaluation (Symposium and Conference).
- Provide feedback to the Leader (Symposium and eMeeting).
- Temporarily step out of an event (Symposium and eMeeting).
- Work in small groups during a Breakout session (Symposium).

Participant Tips

- Be sure the Leader and others can be heard. Run the Saba Centra Audio Wizard if there are problems with audio.
- Ask a question or request a microphone using the raise hand button.
- Press the Ctrl key, the F12 key or click the Talk button to speak for a short time period.
- Click Lock to Talk to speak for an extended time. Click again when done to allow others to speak.
- Running other applications while in session can slow the event.
- If experiencing a technical problem, close the event and then rejoin it.
- Use Text Chat to communicate with the Leader if experiencing technical problems.
- Click Step Out to temporarily leave the event.
- Work with the Tutorial, accessible from the Saba Centra Welcome page and the My Schedule page.
A Saba Centra event can be set up to use either Voice Over the Internet (VOIP) or a Teleconference.

- Attending a Saba Centra event using VOIP, requires a microphone headset.
  
  **Note:** A separate microphone and speakers may be used.

- Attending a Saba Centra event using a teleconference, requires a telephone.

Before participating in or leading an event, set the audio options in the **Saba Centra Audio Wizard** for optimal sound quality. The wizard provides the following:

- Checks the microphone and sound card installation.
- Helps adjust the speaker and microphone volume for optimal playback and recording.
- Allows clear communication with others during an event.

### Using the Audio Wizard

The Audio Wizard opens automatically on the first login to the Saba Centra server.

**Or**

To access the Audio Wizard while in session, click **Tools, Audio Wizard**.

Follow the onscreen instructions in the Audio Wizard.

**Note:** Troubleshooting text appears in a yellow panel across the bottom of the Audio Wizard.

### Teleconference Audio

If an event uses teleconference audio, the audio part of the conference
is carried over a telephone line. Participants should dial into the teleconference when they join the event. The teleconference information (telephone number and access code) displays in place of the Audio Wizard.

**Note:** Speaking does not require using the Ctrl key or F12 key. Recording an event requires installation of the Saba Centra Telephony Gateway or using the Andrea PCTI-3. Use of the Saba Centra Telephony Gateway disables the VOIP.

### Audio Troubleshooting Guidelines

- Run the Saba Centra Audio Wizard, click **Tools** and choose **Audio Wizard**.
- Verify hardware requirements.
- Verify or replace headset, speakers or microphone.
- Shut down all applications not needed for the event.
- Verify the Sounds and Multimedia properties on the computer.
- Check possible connection problems.
Saba Centra provides Saba Centra Agenda Builder to assemble, sequence, and package content into an Agenda; and Saba Centra Recording Studio to create, and edit content.

Note: Using Agenda Builder and Recording Studio requires appropriate privileges.

Using Agenda Builder

Agenda Builder functions as a stand-alone application and allows sequencing content to be used in an event. Internet access is not required.

Opening Agenda Builder

Download the Agenda Builder application from the Saba Centra Server before using it for the first time. Once Agenda Builder is downloaded from the Saba Centra Server, access it without connecting to the server.

Use the following instructions to open Agenda Builder:

1. Log into the Saba Centra Server with appropriate privileges.
2. Click Agenda Builder.

To access Agenda Builder directly, click Start and choose Programs, Centra, Centra Agenda Builder.

Creating an Agenda

Use Agenda Builder to insert text, graphics, PowerPoint, audio, video, multimedia files, and other files into an Agenda.

Use the following instructions to insert a file into an Agenda:

1. In Agenda Builder, click Import.
2. Select a file to insert and click Open.
3. Select the import format:
   - GIF for slides with simple graphics and text.
   - JPG for slides with complex graphics and photographs.
   - HTML for PowerPoint animation or to have the ability to resize the slide. File size will be large.

   **Note:** The Import feature provides the choice of importing PowerPoint slides at 640 x 480 or 800 x 600 for better legibility. Select the image size in the Select image size drop-down menu that appears when importing.

4. Click OK and add additional items or save the Agenda.

**Drag and Drop Content into an Agenda**

Use Drag and Drop to add content to an Agenda. Click and drag the file to the Agenda. The file will insert under the previously selected item in the Agenda Panel.

**Adding an Evaluation**

Add an Evaluation into the Agenda to gain a response from the participants about the event. Use the following instructions to add an Evaluation:

**Note:** Evaluations can not be added to an Agenda during an event.

1. Click Evaluation.
2. Enter all required information.
3. Click **Apply**.
4. Click **Save**.

**Note:** The Evaluation can be saved and Imported into another Agenda.

**Deleting Content from an Agenda**

Use the following instructions to delete content from an Agenda:

1. In the Agenda area, select the content to delete.
2. Press the **Delete** key.
3. In the delete confirmation dialog window, click **OK**.

**Saving an Agenda**

After creating the Agenda, save it to a local drive and upload it to the Saba Centra Server. The file extension for an Agenda is .saz.

Use the following instructions to save an Agenda:

1. Click **File** and choose **Save** or **Save As** (to save the Agenda under a new name).
2. Select the folder to save the Agenda and type in a **File Name**.
An Agenda name can contain up to 255 characters, including spaces. The following characters are not allowed in an Agenda name:
\ / : * ? " < > | % _ ; ! @ $ &

3. Click **Save**.

**Tips for Creating an Agenda**

- Only supported file types appear in the Select a File dialog box. To add unsupported file types, use Drag and Drop or choose *.* from the Files of Type drop-down menu.
- The options shown on the **Edit Properties** box vary, depending on the type of file imported.
- Any items imported into an Agenda are inserted in the Agenda hierarchy directly after the currently selected item.
- Drag and drop Agenda items to move them around.
- Use one color as the background in PowerPoint slides to keep the file size small.
- Keep the Agenda to fewer than 500 items.
- Open two Agenda Builder windows. Copy Agenda items from one Agenda. Paste into the other Agenda.

**Language Considerations for Agendas**

- Updating an Agenda (.saz file), requires the computer has the same regional settings as the computer used when creating the Agenda.
- Uploading an Agenda to the Saba Centra Server that was created with a prior version of Agenda Builder, requires opening and saving the Agenda .saz file in the current Agenda Builder, then uploading.

**Supported Content**

The following list details the various file types supported in an Agenda and conditions for their use. These files appear in the Media Window unless otherwise
<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Text and Graphics** | - Supported file extensions are .txt, .htm, .html, .gif, .jpg, .jpeg, .png, .bmp  
- HTML files that appear in an HTML browser. HTML files can include JavaScript and embedded content such as images and Flash files (.swf). Users need the appropriate plugins (such as Flash, Shockwave, etc.) to see the content.  
- Word, (.doc), Acrobat (.pdf), and Excel (.xls) files are supported. Participants must have the application on their computer to view the content.  
- Total file size should be less than 10MB.  
- File (.gif and .jpg) can be inserted into an agenda as background images. Click **File, Import** and select the file. |
| **PowerPoint**        | - Supported file extension is .ppt  
- PowerPoint 2000 SR2 or higher required  
- Total file size should be less than 10MB for live sessions.  
- Avoid complex or multi-colored backgrounds  
- Slides can be imported as .gif, .jpg or HTML files  
**Note:** PowerPoint XP/2003 with animations cannot be imported as html on a computer with MicroSoft Office 2000, they must be imported as .gif or .jpg files. |
| **Audio and Video**   | - Supported file types and extensions are AVI (.avi), QT (.qt), MP3 (.mp3), SUN (.au), QUICKTIME (.mov), MPEG 1 (.mpg), MPEG (.mp2), REAL (.ra, .rm), WAV (.wav), and Windows Media (.wmv, .asx).  
- Some formats may require a media player application or browser plug-in such as Flash, Shockwave, Active Movie, DirectX Media Runtime, Quicktime, Real Player, or Windows Media Player.  
- Participants must have Real Player version 8.0 or higher installed to view Real Networks media files (.ra, .rm).  
- Participants must have Windows Media Player installed on their computer to view Windows Media files (.asx). |
| **Saba Centra Content** | - Placeholders for Saba Centra tools, Whiteboard, Web Safari, and Appshae  
- Existing Saba Centra Symposium or Conference Agenda created with Agenda Builder  
- Evaluations and Surveys |
| **Other Content**     | - URL (Uniform Resource Locator), link to a Web site  
- Content stored in the Content Catalog or in the Saba Centra Knowledge Center. |
Using Recording Studio

Launching Recording Studio

You can launch the Recording Studio in several ways. Depending on how you launch the Recording Studio, it opens in the Studio Timeline Editor (STE) or Studio Recorder (SR) mode.

You can launch the Recording Studio in the STE mode:

- By choosing to edit an existing recording in Centra (Manage Events > Manage Recordings > Edit).
- By double-clicking the native Recording Studio CCRZ file. The Recording Studio client must be already installed on the machine. The client is installed when you first launch the Recording Studio from Centra.

You can launch the Recording Studio in the SR mode:

- By choosing to create a new recording in Centra (Content Manager > Create Recording).
- By double-clicking the Recording Studio shortcut on the Desktop. The shortcut is created when you launch the Recording Studio from Centra for the first time and download the Recording Studio client.
- By selecting the Recording Studio option from the Start menu. An entry for the Recording Studio is added to the Start menu when you first launch the Recording Studio from Centra and install the Recording Studio client on the machine.

Creating Recordings

To create a recording:

1. Prepare for the recording by performing the following optional tasks:
   - Import an agenda for the recording by clicking the Import button and selecting a .saz agenda file.
   - Import content, including PowerPoint slides, by clicking the Import button.
   - Create Whiteboard content by clicking the Whiteboard button.
   - Use application share to demonstrate software and coach users during the recording by clicking the Appshare button.

2. Start recording by clicking the Record button.
   - To record voice, hold down the Talk button. To talk hands free, lock down the talk button using the Lock button.
   - Switch to full-screen mode during the recording by clicking the Full Screen button.
   - Use the sliding scale to adjust the audio volume for the headset and microphone.
3. Save the recording:
   - Switch to the Studio Timeline Editor (STE) by clicking the Editor button in the Studio Recorder.
   - Save the recording in the Centra format (.ccrz) or export it to the WMV or WAV file format.

Editing Recordings

To edit a recording:

In the Recording Studio you can open and edit recordings in the CCRZ, CCRF, and EXE file formats. When editing a recording, you can:

- Add content using the Import button.
- Delete content by selecting the content area in the timeline and clicking the Delete button.
- Replace audio by selecting the area in the timeline and clicking the Record Audio button.
- Combine (copy and paste) Centra recordings by opening compatible (version 7.5 or later) recordings and copying and pasting the selections in the Timeline Editor.
- Add, remove, or rename index points by using the corresponding buttons in the Timeline Editor.
- Cut, copy, and paste from the Timeline Editor.

When done, save the final version as a Centra recording (.ccrz) or produce a WMV or WAV file. You can also publish the recording to CMS, or Saba Knowledge base if one has been defined in your Centra server.

Saving Recordings

You can save a recording in the Centra format (.ccrz), or export a recording to the WMV or WAV file format. Recordings saved in the Centra format can be published, played, and edited in Centra. Recordings exported to WMV or WAV format can be played in a third-party media player. In addition, you can choose to create an offline playback of the recording (specified in the recording properties) when publishing the recording to the CMS.

Saving Recordings in Transportable Recording Studio Format

You can use one of the following methods to save a recording in the Centra file format:

- From the File menu select Save. For a new recording, you will be prompted for a name and location for the CCRZ file. For an existing recording, the original CCRZ file will be overwritten; or
- From the File menu select Save As. You will be prompted to enter a name and location for the new CCRZ file.
Saving Recordings in WMV or WAV File Format

To save a recording in the WMV or WAV format:

1. From the **File** menu, select **Export**.
2. Select WMV or WAV from the **Save as type** drop-down list.
3. Specify the location and filename for the recording.
An Event Manager creates events, and then enrolls users in an event.

Scheduling an Event

Use the following instructions to schedule an event:
1. Log in to the Saba Centra Server as an Event Manager.
2. Click Manage Events.
3. Click New Event.
4. Enter all required information.
5. Click Create to create the event and make changes later
   Or
   Click Create & Edit Enrollment to create the event and add participants.
   Or
   Continue setting up the event by entering the remaining information.

Choosing a CODEC
The Audio section of the Manage Events page allows Voice Over Internet Protocol (VOIP) or Telephone. When choosing VOIP, select the appropriate CODEC. The CODEC (converts digital signals to and from analog format) that provides the best audio quality for an event or meeting.

Note: Choose a low bit rate CODEC if at least some of the participants will be using low bandwidth connections. Saba Centra SC3 is recommended for modem users.

6. When complete, click Create to schedule the event on the selected server
   Or
Click **Create & Edit Enrollment** to enroll users in the event. Refer to See “Enrolling Users or Groups” for information on enrolling users.

**Registered Users Only Events**

The new Event property, **Attendees Must be Registered Users**, restricts attendance at a particular event to users with a user account.

When this property is selected, users can attend an event only by providing the user name and password of a registered account. Selecting this property does not prevent the event from being displayed in the Public Event List that is shown to users who have not logged in.

This property appears in the Event Options section of the Edit Event page, which administrators access by clicking Modify in the entry for an event on the Manage Events page. By default, this property is not selected.

**Scheduling Tips**

- The server allows creating events with the same name.
- The default day is the current server system clock date and time. The time zone provides an offset from the Saba Centra Server’s system clock so the event appears in the Event List as the current time on the user’s schedule.
- Enrolled Participants can log into the event at anytime before the scheduled start time.
- If a specific time is scheduled for an event, the event automatically moves from the user’s “Upcoming” to “Past” tabs on their My Schedule page when the time has passed.
- The Leader is included in the enrollment count and all members in a group are counted individually.
- The server license determines if individuals are allowed to create events.

**Setting up Virtual Labs (for Symposium Events Only)**

After creating an event, if the Surgient VTMS integration is enabled, to assign a virtual lab for the event:

1. From the home page, click Manage Events.
2. Click the Add Lab link for the desired event.
3. Enter the following information:
   - Name: any name for the lab; defaults to the event name.
   - Configuration: from the drop-down list, choose the lab configuration template.
   - Start Time: start date and time of the lab; defaults to the event start time.
[List of points]

- Duration: time length of the lab; defaults to the event duration.
- Instructor: from the drop-down list, select an instructor for the lab.
- # of Labs: specify total number of participants including the instructor; defaults to the enrollment limit.

4. Click Add to save the lab configuration.

## Enrolling Users or Groups

After creating an event, enroll users or groups of users. See “Guest Attend” for information on groups.

Use the following instructions to enroll users or groups in an event:

1. Log in to the Saba Centra Server as an Event Manager.
2. Click Manage Events.
3. Locate the event to enroll the users and click Edit enrollment.
4. If necessary, click the Add To Enrollment tab.
5. Locate the name of the user or group of users to enroll, and click Enroll.

If enrolling multiple users or groups at once, select the users and/or groups by selecting the checkboxes next to the logins or click Select All to select all users and groups on the page. Then click Enroll Selected.

The users and/or groups are immediately enrolled in the event.

If the Saba Centra Server is configured for automatic email, the enrollment email opens and allows the following:

- Changing the subject.
- Inserting additional text (in two places in the message).
- Clicking the Include optional text in outbound message? checkbox to include a URL to a Guest Attend page. See “Guest Attend” for more information.
- Clicking Send Email to send the email.

## Special Roles in an Event

When scheduling an event and enrolling users, the users are automatically enrolled as Participants. Appoint a Leader to conduct the event. Appoint a Recorder to record the event using the Client-side Event Recorder, and a Remote Application Host to share a remote application.

If this is a Conference event, designate up to four other enrolled Participants as Co-Presenters. They must be specified before the event, and they have access to the full range of interactive tools. In Symposium events, Leaders can promote a Participant to a Co-Presenter only while in session.
Assigning Special Roles

Use the following instructions to assign special roles for a Symposium or Conference event:

1. Log in to the Saba Centra Server as an Event Manager.
2. Click Manage Events.
3. Locate the event and click Edit enrollment.
4. If necessary, click the Current Enrollment tab.
5. Locate the individual to appoint a special role.
6. In the Leader, Recorder, Co-Presenter, or Host columns, click No. The Saba Centra Server updates the column to read Yes and the individual is appointed to the special role (this is a toggle).

Tips

- Only one user can be assigned to the Leader role at a time. When assigning the Leader role to another user, that person becomes the Leader.
- A Leader or Co-Presenter can also have the role of Recorder. More than one person can be assigned to be the Recorder.
- Multiple users can be assigned to the Remote Application Host.
- A Conference event can have up to four Co-Presenters.

Guest Attend

Guest Attend allows users to attend a Symposium, Conference, or eMeeting event without being pre-registered and pre-enrolled. Guest users can only access a private event using the Guest Attend page. A URL brings users directly to the Guest Attend page.

Note: Guest users are counted in the enrollment limit and the number of active accounts.

Select Allow guest attendees in the Event Options area to use this feature. For eMeeting, this option is selected by default. If this option is not selected, users cannot attend the event from the Guest Attend page unless they have been pre-enrolled.

Use the following instructions to locate the URL for the event:

1. Log in to the Saba Centra Server as an Event Manager.
2. Click Manage Events.
3. Locate the event.
4. Click Modify associated with the event.
5. Copy the Guest Attend URL in the Event Options area.
A Leader uses the Saba Centra interface to conduct an online, real-time event with Participants. The Leader controls the pace and flow of the event, and determines who has microphone and AppShare control.

Before Beginning an Event

- Find a comfortable, quiet place to deliver the event.
- Set up the area with a script, notes, water, and a clock.
- Launch any applications to share.
- Create surveys.
- Check Web site URLs to launch in Web Safari.
- Import slides, files to download, or agendas, as necessary.
- Run the Saba Centra Audio Wizard (and Video Wizard, if applicable).
- Speak briefly with each Participant. Verify each Participant can hear.

Inviting Additional Participants

Invite additional participants using:

- Invite eMail
- MicroSoft Instant Messenger

Note: This function is available if it is enabled on the Server.

Using Invite

Use the following instructions to invite another person through email:

1. In the Presenters Panel, click Invite.
Note: Invite uses the default email program on the computer.

2. In the Invite by Email dialog box, enter the email address and any additional message. Modify the subject if necessary.

3. Click OK.

Note: The recipient can attend by clicking the link inside the message.

Using Microsoft Instant Messenger

Use the instruction to invite other using Microsoft Instant Messenger:

1. Click Tools and choose Invite by IM.
2. Select a name from the IM list.
3. Modify the message as necessary.

Note: The recipient can attend by clicking the link inside the message.

Leader Functions

Leaders have the following capabilities available when right-clicking on participants:

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clear Microphone/Markup Tools</td>
<td>Removes microphones or markup tools from the participants.</td>
</tr>
<tr>
<td>Give or Clear Appshare Control</td>
<td>Gives the participant to control the Appshare window or clears the participants control of the Appshare.</td>
</tr>
<tr>
<td>Ask to Share Application</td>
<td>Opens a dialog on the participant's machine, prompting them to select an application to share.</td>
</tr>
<tr>
<td>Send Text Chat</td>
<td>Send a Text Chat to a specific participant.</td>
</tr>
<tr>
<td>Adjust Audio</td>
<td>Allows adjusting the participants audio or prevent audio feedback.</td>
</tr>
<tr>
<td>Promote or Demote Co-presenter</td>
<td>Allows the leader to promote and demote co-presenters from the participant list.</td>
</tr>
<tr>
<td>Eject from the Event</td>
<td>Enables the leader to eject a participant from an event.</td>
</tr>
<tr>
<td></td>
<td>Note: Once a participant is ejected from an event, that participant will not be able to attend the event.</td>
</tr>
<tr>
<td>Grant Video Camera</td>
<td>Allows the leader to pass video control to another present or a participant.</td>
</tr>
<tr>
<td></td>
<td>Note: Video must be enabled for this function to appear.</td>
</tr>
</tbody>
</table>
Importing a PowerPoint Presentation

Insert a Microsoft PowerPoint presentation into an Agenda before or during an event.

Use the following instructions to import a PowerPoint presentation into an event:

1. Click **Import** located above the Agenda.
2. Select a file to insert and click **Open**.
3. Select the import format:
   - **GIF** for slides with simple graphics and text.
   - **JPG** for slides with complex graphics and photographs.
   - **HTML** for PowerPoint animation or to have the ability to resize the slide. File size will be large.

   **Note:** The Import feature provides the choice of importing PowerPoint slides at 640 x 480 or 800 x 600 for better legibility. Select the image size in the Select image size drop-down menu that appears when importing.
4. Click **OK**

   Each PowerPoint slide is imported into the Agenda. The imported slides appear in the Agenda area of the Import Tool dialog box and Import Completed appears when done.

**Import Tips**

- Use Microsoft PowerPoint 2000 SR2 or higher.
- The PowerPoint presentation should be smaller than 10MB.
- Multiple presentations can be imported.
- Participants do not need PowerPoint to view the presentation.

   **Note:** Exception, for PowerPoint XP or 2003 with animations, participants require RunTime from MicroSoft to view the presentation. The participants will be prompted to install RunTime.
- PowerPoint XP or 2003 animations requires Office XP or 2003 on the computer.

**Inserting a URL**

Insert a URL into the Agenda of an event. Use the following instructions to insert a URL into an Agenda:

1. Click **File**, and choose **Insert URL**.
2. Follow the onscreen instruction.
3. Click **OK**.
Inserting an Agenda

Insert an Agenda built in Agenda Builder into an ongoing event.

Use the following instructions to insert an Agenda:

1. Click Import.
2. Select the Agenda and click Open.

The selected Agenda will be uploaded to the server and the Agenda items will appear in the listing in the lower left corner of the interface.

Inserting a File to Download

Use the following instructions to insert a file to download:

1. Click File, and choose Insert File to Download.
2. Select the file and click Open.
3. Click Open.

The name of the file to download appears in the agenda.

When the Leader clicks on the item in the Agenda, a page displays in the media window instructing the Participants how to either display the content in the media window or download the content to their machines.

Clearing the Agenda

The Clear Agenda option returns the agenda displayed in the Agenda Panel to the state that it was in when the session started. Clicking Clear Agenda removes any Just-in-Time (JIT) content that was added to the agenda and removes any slide mark up. Clear Agenda reverses only the additions or deletions that were made during the current session.

Use the following instructions to clear the Agenda:

1. Click File, and choose Clear Agenda.
2. In the confirmation dialog window, click OK.

Important: This action removes the entire Agenda.

Co-Presenters

In events, the Leader can promote participants to be “Co-presenters.” The Event Manager must designate Co-Presenters before a Conference event. The Co-presenter can perform many of the tasks of the Leader.

If the Leader leaves the event, the Co-Presenter can run it.
A Co-Presenter cannot create, start, or stop a Breakout Session (Symposium only).
Note: The Co-Presenter privilege can not be given to a Participant who stepped out. A Co-Presenter can click Step Out to temporarily leave the Main Room before and during a session. The Co-Presenter must click Step Out to return to the Main Room.

Showing Content in Session

Use an Agenda during an event as a guide to select and show content and tools. Navigate, or step through Agenda items to launch tools or show files.

Use the following instructions to display Agenda items, keep these tips in mind:

- Click on an Agenda item to view the item in the Media Window. The item also appears in each Participant’s Media Window (if in session).
- Visited agenda items change to purple, non-visited items are blue.
- Roll the mouse over the Agenda item to view the full title.
- In pre-session mode in Symposium and Conference, Agenda items that are not available out of session appear grayed out.
- If content was imported in HTML format, resizing the Media Window resizes the slides to fit the window.
- If Participants do not have Internet Explorer on their computers, they will not see PowerPoint animations. Instead, they will see a static .gif of the last transition slide.

Navigating the Agenda

- Click on any item to select it.
- Expand or collapse the folders in the Agenda by clicking on the boxed + or - button.
- Use the Next and Previous arrows in the Agenda area to step through Agenda items in order.
  Tip: For slides containing animation, click the Next button to step through the number of animations involved within the slide.

Deleting Imported Content

Only event Leaders can delete individual slides or an entire PowerPoint presentation from an Agenda that they imported into an event. Also, use these procedures to delete an inserted URL, a saved Whiteboard or slide item, a file to download, or an item in an inserted agenda.

Use the following instructions to delete a slide or individual piece of content or a PowerPoint Presentation imported during the event:

1. Select the items to remove from the Agenda.
2. Click **Edit**, and choose **Delete**.
3. Click **OK**.

### Using Web Safari

Web Safari lets Leaders or Co-Presenters share and display Web sites and active Web site links during an event.

- In a Symposium, eMeeting, or a Breakout session, Participants must have Appshare privileges to interact with Web Safari.
- In a Conference event, Participants cannot interact with Web Safari.

Use the following instructions to use Web Safari:

1. Click **Web Safari**. If a Web Safari placeholder is included in the Agenda, click the Web Safari Agenda item.
   
   A new instance of the default Web browser launches and the Web Safari Welcome page appears in the upper left corner of the screen. The Saba Centra interface changes to Application Host View. Continue to work with the Leader interface while viewing Web sites.
2. Use the Web Safari browser to select, show, and browse Web sites.
   
   **Tip:** When controlling the browser through Web Safari, press Lock to Talk or use Voice Activation to speak.
   
   If another window appears in the browser, a message appears asking to share the window. Click **Yes** to share.
3. Use the Appshare markup tools to point to items in the window. See “Marking up an Application” for more information.
4. Click on a different Agenda item or choose another tool to stop Web Safari or choose quit Appshare from the Appshare tools menu.

### Using Appshare

Appshare (application sharing) allows opening an application and sharing the application with everyone in an event. The application appears in the Participant’s Media Window.

In Symposium and eMeeting, Participants with Appshare privileges can share and interact with applications. They do not need to have the application on their computer to interact. The Leader can prompt a Participant to share an application.

In Conference, the Leader or Co-Presenter can show and interact with applications. Participants can view the application, but cannot share or interact with the application.

Use the following instructions to share an application:

1. Launch the application to share.
2. Click **Appshare** or select **Tools, Share Application**.

   **Note:** Symposium and Conference (eMeetings if the Agenda was imported) allow accessing Appshare through an Agenda. The Appshare function can be accessed directly from the Agenda. Click the Appshare item in the Agenda.

3. Check the boxes for the application(s) to share and click **OK**.
   The Saba Centra interface changes to Application Host View. Participants view the application in the Media Window.

4. Interact with the application.
   **Tip:** When hosting Appshare, press Lock to Talk.
   If another window appears in the browser, a message appears asking to share the window. Click **Yes** to share.

5. Use the Appshare markup tools to highlight an area of the application. See “Marking up an Application” for information.

6. Click on a different Agenda item or toolbar button/menu bar item to stop Appshare.

### Marking up an Application

Use the Appshare markup tools to highlight areas of the application and change Appshare settings. (This feature also applies to Web Safari.)

Use the following instructions to mark up an application:


2. Click the down arrow and select **Markup Mode**. The cursor changes to a pencil in the shared application.

3. Use the pencil to highlight an area of the application.

4. Make changes using the Appshare tools menu options:
   - Select **Markup Color** to pick another color. The Color dialog box appears. Select the desired color and click **OK**.
   - Select **Clear Markup** to clear the markup from the screen.

5. If desired, select **Pause Application Sharing** to make changes to the shared application without letting the others in the event see them. The menu changes to **Paused**. Interact or markup the application. Select **Resume Application Sharing** to let all others see the changes.
   **Note:** Only the individual hosting the application can resume Appshare after it is paused. Do not pause Appshare when remote hosting.

6. Optional, select **Snapshot** to take a snapshot of the application and save it to the agenda.

7. Select **Exit Markup Mode** when done. The markup disappears.
Appshare Options

Appshare Control Options include:

- Microphone also allows or does not allow Appshare control
- Colors to be transmitted and the refresh rate

Use the following instructions to set Appshare control options:

1. Click **Tools, Options**.
2. Click the **Appshare** tab.
3. Select one of the following:
   - **Microphone also allows Appshare control** - Provides Appshare control and a microphone when granting microphone control.
   - **Microphone does not allow Appshare control** - Provides separate AppShare control and microphones (default) granting control independently.
4. Specify the color depth to be transmitted using the list under **Colors**. True color requires a higher bandwidth. Appshare with 256 colors may cause applications to appear slightly different for the host and the viewers.
5. Specify the Refresh Rate by using the sliders controls under **Refresh Rate**. A fast refresh rate requires higher bandwidth.
6. Click **OK**.

Using the Whiteboard

The Whiteboard permits collaboration on a project while in an event.

Click **Whiteboard**.

The Whiteboard appears in the Leader’s and Participant’s Media Window. The Markup toolbar appears above the Whiteboard. Use the markup tools to enter text, draw lines, highlight images, create simple shapes, or draw.

Participants must have microphone control to use the Whiteboard. As the Leader or Participants work with the Whiteboard tools, the content of the Whiteboard is visible in everyone's Media Window.

Users can add graphics, such as lines, squares, and circles. These graphics can be moved as objects on the Whiteboard.

Saving the Markup to the Agenda

Use the following instructions to save the Whiteboard or marked-up slide to the Agenda:

1. Click **Save to Agenda** on the Markup toolbar.
2. Type a name for the display in the Name field.

3. Click OK to save or Cancel to cancel the operation.

The saved Whiteboard or marked-up appears at the bottom of the Agenda.

Clearing the Markup

Use the following instructions to clear the Whiteboard or marked up slide:

- Click Clear Whiteboard on the Markup toolbar remove all content. Click OK to confirm the removal.

  Note: Click Edit and choose Undo to restore the cleared content.

- Click Eraser to remove a specific markup or Drag Erase to select multiple objects on the Whiteboard markup to remove.

Creating a Survey

The Survey tool allows the Leader, Co-Presenter, or Breakout Leader (Symposium only), to create a quick, one-question-at-a-time poll to Participants during an event. Create a survey before or after beginning an event. Surveys must have a question and at least one answer. The survey tool provides several pre-defined survey templates that can be duplicated and modified for use in the event. Changes made to the templates for use during a session are not saved when the session ends.

Use the following instructions to create a survey while in session:

1. Click Survey.

2. Click New Survey.

3. Type the Survey question in the Question text box.

4. Enter possible answers in the Answer text boxes.

   - Color buttons, enable specifying the display color for responses to each question.

   - Font button, enables specifying the type face, type size, and other print characteristics of the questions in the survey.

5. Click OK.

6. Click Show Survey to show the survey to Participants.

   The Survey appears in each Participant’s Media Window.

   As each Participant responds, the Media Window updates to reflect the responses.

7. Select Show results to All so Participants can view Survey results.

8. Create another Survey question or edit an existing one, click the survey from the list and click Edit Survey.
9. Click Agenda to return to the presentation.

Create multiple Surveys and use them throughout the event. After creating one or more Surveys, open the Survey window, select a Survey, and click Show Survey.

The survey tool provides several pre-defined survey templates that can be duplicated and modified for use in the event. Changes made to the templates for use during a session are not saved when the session ends.

Displaying an Evaluation

An Evaluation is a collection of questions Participants answer on their own. Use Saba Centra Agenda Builder to create and insert an Evaluation into an Agenda.

Use the following instructions to display an Evaluation in an event:

1. Click on the Evaluation item in the Agenda area.
2. Ask Participants to answer the questions and click Submit when done.
3. In the Evaluation, click Update to view incoming Evaluation results.

   The results show the number of Participants who chose a specific answer.
   After submitting an Evaluation, Participants cannot change their responses.

Using Breakout Rooms

A Breakout Room is a virtual 'room', separate from the Main Room where a group of Participants and a Breakout Leader work together. Breakout Rooms are available in Symposium only.

Creating Breakout Rooms

Create a Breakout Room before or during an event.

Use the following instructions to create and configure Breakout Rooms:

1. Click Breakout

2. In the Create rooms area, select one of the following:
   - Number of Breakout Rooms. Use the arrow keys to select the number of rooms to create.
   - Minimum number of Participants per Room. Use the arrow keys to select the minimum number of Participants per room.

3. To manually assign members to Breakout Rooms, clear the Auto-assign Participants to Rooms checkbox.

Note: The Auto-assign Participants to Rooms option randomly assigns Breakout members to each Breakout Room. Co-Presenters remain in the Main Room. Manually move Co-Presenters into Breakout Rooms to participate.
4. Click **OK**.
5. Click and drag the participants to the specific Breakout Rooms.

**Note:** To change the Breakout session configuration, click **Reconfigure** to re-open the Breakout Tool dialog box.

### Moving a Participant to a Room

Create the Breakout Rooms and move the Participants to specific Breakout Room or to the Main Room, before or during a Breakout session.

Use the following instructions to move a Participant:

1. In the Breakout Tool window, select the name of the Participant.
2. Right-mouse click and select **Move Participant To**.
3. Select the room from the pop-up menu. The Participant moves to the selected room.

### Selecting Breakout Room Content

Select specific content for a Breakout Room before starting the Breakout session or during an event. By default, each Breakout Room sees the entire Agenda as its content.

Use the following instructions to select Breakout Room content:

1. In the Breakout Tool window, right-mouse click on the name of a Breakout Room.
2. Choose **Select content**.
3. Select an Agenda item. Select a specific Agenda Item or a folder. When selecting a folder, all items within the folder are available to the Breakout Room.
4. Select **Apply to all breakout rooms** to apply the content selection to all Breakout Rooms.
5. Click **OK**.

The selected content appears as a book button within the Breakout Room.

### Changing Breakout Roles

Assign a new Breakout Room Leader before or during a Breakout session.

Use the following instructions to assign a new Breakout Room Leader:

1. Select the user in the Breakout Tool window.
2. Right-mouse click and select **Make Participant room Leader** from the popup menu.

A Breakout Room can have only one Leader, the previous Leader automatically changes to a Breakout Participant.
Starting and Stopping Breakouts

In the Breakout Tool window, click **Start** to begin the Breakout session.
In the Breakout Tool dialog, click **Stop** to end the Breakout session.

Click **Close** in the upper right corner of the Breakout Tool window. The Breakout Leader and Participants return to the Main Room.

Symposium and eMeeting Leader

Symposium and eMeeting also include an auto-sort feature, that allows user to sort Participant panel:

Use the following instructions to sort Participants automatically:

1. Click the column headers to sort the Participant area. In this example, raised hand was chosen.
2. The participants automatically sort by a raised hand. Other choices include microphone, yes response or alphabetically.

**Note:** Click the previously selected sort to shut it off. The participants will appear in the order they joined the event.

Conference Leader

In Conference, the Participant List shows the Participants with their hands up or with a microphone. The Event Manager or Leader can select whether to show or hide the number of Participants in an event to all users. Use the following instructions to allow participants to view the complete participant list:

1. Click **Tools** and choose **Options**.
2. Click the **View** tab.
3. Select **Hide Audience total from participants**.

**Note:** Leaders always view the complete participant list.

Leader Tips

- Become familiar with the event content.
- If working with a Co-Presenter, decide who is doing what.
- Speak clearly in an animation voice.
- Use the **Lock to Talk** button when speaking for a long time. Click again to shut off to allow others to speak if the session allows one concurrent speaker.
- Provide frequent and varied interactions. Vary tool usage.
- Encourage Participant response.
- Give explicit directions to Participants.
- Ask for frequent feedback.
- Remember to clear Yes, No, and Raised Hands.
- Remind Participants to hold down the **Ctrl** key, **F12** key or click the **Talk** button to speak.
- Remind Participants that running other applications while in session can slow their event.
- If a Participant is experiencing a technical problem, suggest closing the event and then rejoining it.
- Ask Participants to use Text Chat if they continue to experience technical problems.
- Remind Participants to click **Step Out** to temporarily leave the event.
- Keep total event duration from one to one and a half hours, if possible.
- Practice!

Managing Virtual Labs (Symposium Events Only)

Accessing the Manage Virtual Labs Page

To access the Manage Virtual Labs page, from the **Tools** menu, select **Labs** > **Manage Virtual Labs**.

The **Manage Labs** dialog box appears displaying the basic lab information including total number of participants, total number of lab slots, total number of available lab slots.
Assigning Labs

You can assign labs in one of the following ways:

- The **Assign** button assigns selected participants to available slots. The button is disabled if the number of selected participants exceeds the number of available slots. You can use the **Assign** button to assign participants arrived after the lab session has been started.

- Clicking the **Start Labs** button assigns all selected participants to the available slots and starts the labs. The button is disabled if the number of selected participants exceeds the number of available slots.

Replacing a Lab Assignment

The **Replace** button allows replacing a current assignment with a new participant; however, the assignment from the previous user is saved and cannot be cleared. The new user can only continue the session, but cannot start a new one.

Starting and Stopping Labs

Use the **Start Lab/Stop Lab** buttons in the Manage Virtual Labs page to enable or disable the lab access.
Monitoring Labs

To monitor lab resources, status, and invoke student shadowing (view student lab environment), launch the VTMS Console page in one of the following ways:

- The VTMS Console page is launched when clicking the Start Labs button; or
- From the Tools menu, select Labs > Monitor Labs; or
- Click the Monitor button in the Manage Labs dialog box.

Broadcasting Video

Leaders can control video broadcasting by doing the following:

- Turn video broadcasting on and off for an event.
- Select or deselect Multi-Video broadcasting.
- Grant video control to and take it from any participant in the session. Video can be broadcast by the leader, by co-presenters, and by participants.

  Note: Participants in Conference events cannot broadcast video.

- Enable and disable automatic switching of video control.

The following terms are used in this chapter:

<table>
<thead>
<tr>
<th>Term</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Presenter</td>
<td>The leader or a co-presenter of an event or meeting.</td>
</tr>
<tr>
<td>Broadcaster</td>
<td>The presenter or participant with video control.</td>
</tr>
<tr>
<td>Viewer</td>
<td>The presenter or participant watching the video broadcast.</td>
</tr>
</tbody>
</table>

Enabling Video Broadcasting

System administrators can enable and disable video broadcasting in Symposium and Conference events and eMeetings by setting domain properties. These properties enable System Administrators to do the following:

- Enable or disable video broadcasting for all events and meetings created in the domain. Creators of events and meetings cannot override this enabling or disabling of video broadcasting.
- Enable or disable video broadcasting for all events and meetings created in a domain as a default. Creators of events and meetings can override this default for individual events or meetings.

If video broadcasting is enabled or disabled as a default, creators of events and meetings can override the default by doing the following:

- Select or deselect Live Video under Meeting Options when creating the meeting in the Create Meeting page.
- Select or deselect Live Video under Session Options when creating the Symposium or Conference event in the Event Manager.
By default, video broadcasting stops when Application Sharing begins. Video broadcasting must be restarted manually when Application Sharing stops. A System Administrator can override the default by setting the **Video allowed during appshare?** domain property to Yes. Setting this property to Yes makes it possible to broadcast video during Application Sharing.

**Note:** Broadcasting video while Application Sharing may require additional network bandwidth.

### Enabling and Disabling Video During a Session

During a session, a presenter can turn on video for the event by clicking the Video button in the presenter's toolbar. When video is turned on, the video panel is displayed. If the presenter who turned video on has a camera, the presenter’s video broadcast is displayed in the video panel.

If the presenter has no video camera, a disabled-camera image appears in the video panel. Video panels also appear for all other participants, displaying the presenter's live video broadcast.

The Video button is engaged after being clicked. Clicking the engaged Video button stops the video for the event and hides the video panel from all users. The Video button is disengaged after being clicked.

Presenters can also turn video on and off during a session using the Video On and Video Off items in the Video sub-menu. These menu items provide the same functionality as the Video button in the Leader's toolbar.

### Using the Saba Centra Video Wizard

Use the following instructions to change video camera selections and preview video before starting a session.

1. Select **Tools, Video, Video Wizard**. The Video Wizard opens.

2. Select the video camera to use from the drop-down list and click **Next**. This step is not necessary if only one video camera is in use.

3. Focus the camera and position it at the desired angle and distance.

4. Disable the reversed, mirror-image camera view, uncheck the **Mirror Locally** box (checked by default).

5. Click **Finish**.

If no camera is connected to the computer, the following error message is returned:

```
No Video Camera Detected. Check that your camera is plugged in properly and that the correct drivers are installed. DirectX 8.0 or greater is required.
```

**Note:** If a broadcaster opens the Video Wizard during a session while video is broadcasting, that broadcaster’s video broadcast pauses for all viewers. It resumes when the broadcaster finishes using the Video Wizard.
Starting Video Broadcast

**Important:** Test cameras outside of Saba Centra 7 before starting video in a session. Use the following instructions to start a video broadcast:

1. Start Symposium and begin the session, or start Conference or eMeeting.
2. Click **Video**.
   - The video button appears only if video has been enabled for the session. In Symposium, the video button is grayed out until the session begins.
   - The video appears in the Video panel above the participant’s panel.
3. To stop video for the event, click **Video**.

Selecting Single-Video or Multi-Video Mode

Video can be broadcast in either Single-Video mode or Multi-Video mode:

- In Single-Video mode, the video panel displays video from only one broadcaster. Thus, only one person can broadcast video at a time.
- In Multi-Video mode, 2, 3, or 4 users can broadcast video at the same time.

The System Administrator can disable Multi-Video mode by setting the value of the **Maximum number of video channels** domain property to 1. Setting this property to a value greater than 1 enables Multi-Video.

If Multi-Video mode has been allowed by the System Administrator, presenters can start Multi-Video mode during a session by selecting the **Tools, Video, Multi-video**.

Video Panel

The Video panel appears above the Presenters panel. In Single-Video mode, the panel contains a single video frame, displaying video from a single broadcaster. In Multi-Video mode, the panel can contain up to 4 video frames, each displaying video from a different broadcaster. The Multi-Video panel is always undocked and free-floating.

To view the full video screen, click the **Undock** button in the video panel title bar.

**Note:** The recommended size for video in the Multi-Video Panel is 176 x 144. If the frame is enlarged beyond this recommendation, performance may be affected and it may not be possible to see all the frames in the Multi-Video Panel, depending on the screen resolution.

Using Video Controls

The following video broadcasting controls are available to leaders and co-presenters:

- **Play** and **Pause** appear on the Broadcasters’ video panel. Pause the video broadcast by clicking **Pause** and resume the video broadcast by clicking **Play**.
A broadcaster who is not the leader has a Stop button that passes video control back to the leader.

All users except the Leader can disable video for themselves by selecting the Hide Video item from the Video menu. Users with disabled video cannot be granted a camera or display video.

Using the Video Menu

Use the Video sub-menu to turn video on or off, pause or play Video, Show or Hide video (co-presenters and participants only).

Leaders can select Normal Size or Full Size Video for the event.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Normal Size Video</td>
<td>The video panel appears above the participants panel. The video panel is docked. Normal size video can be a maximum (default) size of 176 x 144.</td>
</tr>
<tr>
<td>Full Size Video</td>
<td>The video panel is undocked and expands it to the size set in the domain properties (if that is larger than the default). Full size video default is 176 x 144 but can be as large as 640 x 480.</td>
</tr>
</tbody>
</table>

Note: The maximum size to which participants can expand the video panel (both normal video and full video) is set by the System Administrator.

Granting Video Control

A leader can grant video control to a co-presenter or participant at any time during the broadcast and as many times as necessary.

- In Symposium and eMeeting, a leader can pass video control to any co-presenter or participant who has a camera.
- In Conference, a leader can pass video control to any co-presenter who has a camera, but not to participants.

When a co-presenter or participant becomes the broadcaster, three buttons appear in the participant’s video panel: Play, Pause, and Stop. If the participant clicks Stop, video control passes back to the leader.

Note: If no camera is connected to the leader’s computer, the leader can start video for the event and pass video control to a co-presenter or participant.

Auto Switching (Single Video Mode Only)

When auto switching is enabled, video control passes automatically to the presenter or participant who is currently speaking. That person then becomes the video broadcaster. When more than one person is speaking at the same time, the leader is granted video in preference to co-presenters and co-presenters are granted video in preference to participants.
To enable automatic video switching, select **Tools, Video, Auto Switching**. If control passes to a user who has no camera, no video camera graphic appears in the Video panel for that participant or co-presenter.

**Note:** Automatic video switching is not available in Multi-Video mode.

**Manual Video Switching**

When manual video switching is enabled (the default), video control passes to the presenter or participant to whom the leader grants a camera. That person then becomes the video broadcaster.

Use these instructions to switch video control to another person manually:

1. Right-click a participant’s name in the participant list or the co-presenter’s name in the presenter’s area.
2. Select **Grant Video Camera** from the pop-up menu.

   This option is not visible when the participant does not have a camera or has selected **Hide Video**.

Use these instructions to regain video control manually:

1. Right-click the Leader’s name in the Leader panel and select **Grant Video Camera** from the pop-up menu.
2. Click the **Show My Camera** button in the video panel or in the Video sub-menu. Only presenters have the Show My Camera button and menu item.